
YET ANOTHER NEWSWATCHER 2.3.1 READ ME

Please read all of this document thoroughly before trying to run Yet Another NewsWatcher for 
the first time. You should also have read and be familiar with the user guide for the original 
NewsWatcher program by John Norstad. More detailed information on various YA-NewsWatcher 
features is discussed in the user guides “YA-NW and Binary Posting”, “YA-NW and Filtering”, 
“YA-NW and Sorting/Threading”, “YA-NW and Character Sets”, “YA-NW Files and Folders”, 
“YA-NW and Anonymity”, and “YA-NW and Scripting”.

You can now register YA-NewsWatcher. Please see the “Registering YA-NW” folder that came 
with the program distribution archive for details and the Register application. By registering 
the program you help to ensure that it will continue to be developed and supported.

Yet Another NewsWatcher is a Usenet newsreader application for Macintosh featuring binary 
and anonymous remailer posting, article filtering (kill files), and article sorting. Please see 
“Program Information” below for who to blame for what.

WHAT'S INCLUDED IN THIS DISTRIBUTION

• NewsWatcher: a fat binary version of Yet Another NewsWatcher
• a number of text files that document the various features that YA-NewsWatcher adds to 
original NewsWatcher. It does not contain the original NewsWatcher user document, which you 
should obtain and read carefully.
• some sample AppleScripts that can be modified to permit YA-NewsWatcher to use MacPGP to 
sign messages, check PGP signatures on articles, etc.

You may also need to obtain one or more of the following helper or applications:
• YA-NW Filter Converter: a application for converting VA-NewsWatcher or YA-NewsWatcher 
filter (kill) files to the new format used by YA-NW 2.0.4 and later
• YA-Base64: a helper application for decoding MIME Base64 encoded as well as uuencoded   
attachments. This is the preferred uudecode and Base64 decode helper application.
• YA-NW Filter to TEXT: a utility application for converting YA-NewsWatcher filter files to plain 
text files that can be edited with a text editor.
• YA-NW TEXT to Filter : a utility application for reconverting a plain text file back to a 
YA-NewsWatcher filter file.

If you are running YA-NewsWatcher after having previously used the original NewsWatcher, 
when the program starts you will receive an error message about preferences being not found, 
damaged, or invalid. This is normal. These are the preferences that YA-NewsWatcher adds for 
the extra features it offers.
 
 
IMPORTANT

YA-NewsWatcher has been proven to be a stable program that runs well and reliably on most 
peoples' Macs. If you encounter problems, here are some things to try/look out for:

• Set a reasonable preferred memory size for the application. The default size seems to work 
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for many people with full group lists up to about 16000 or so. Increasing the memory to 2560 
kB may help for very large full group lists for normal day-to-day use. Please see the original 
NewsWatcher manual for a discussion of memory usage. Note that, if you have more than just 
the subject and author headers shown in message windows, or if you have the “Use XOVER” 
option enabled, you may need to further increase the amount of RAM allocated to 
YA-NewsWatcher, especially if you open newsgroups containing many articles. You may also 
need to increase the memory allocated to YA-NewsWatcher if you create filters that require 
fetching additional headers.
• Make sure you have your location and time zone specified correctly in the Map and Date & 
Time control panels. Setting your location is important for the correct operation of the various 
date handling routines.
• Set a reasonable maximum number of articles to fetch, such as 600, rather than the 
standard default value of 15000.
• Make sure you're using the most recent version of MacTCP (2.0.6) or Open Transport (1.1), 
and have installed all the appropriate system software updates (7.5.1 for example).
• Try running without sometimes troublesome extensions like Aaron, RamDoubler, etc.
• As a last resort, trash your old prefs and/or filter files, and see if that makes any 
difference.

PROGRAM INFORMATION

Yet Another NewsWatcher is free. It may not be sold for profit or included with software or 
other products which are sold for profit without the permission of Northwestern University. 
Otherwise it may be freely distributed.

However, to support further program development, and to give thanks for what has already 
been done the past two years, you can now register YA-NewsWatcher. Please see the 
“Registering YA-NW” folder that came with the program distribution archive for details and the 
Register application. By registering the program you help to ensure that it will continue to be 
developed and supported.

Yet Another NewsWatcher was developed by Brian Clark based on the original NewsWatcher 
application by John Norstad.  Please report any problems you find to the author,  but PLEASE 
read the NewsWatcher manual and the Yet Another NewsWatcher documents FIRST to see if 
the matter is discussed there. It is also an excellent idea to see what problems or solutions are 
being discussed in the newsgroups comp.sys.mac.apps and comp.sys.mac.comm.

   mailto:baclark@enteract.com

The home ftp site for The Yet Another NewsWatcher program, the various filter file utility, and 
YA-Base64 helper applications is:

   ftp://ftp.enteract.com/users/baclark/

The anonymous FTP site for the original NewsWatcher program, the user document, and the 
CodeWarrior C source code is:

   ftp://ftp.acns.nwu.edu/pub/newswatcher/
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NewsWatcher (both versions) requires a Macintosh running System 7.0 or later with 2.5 
megabytes or more of memory and a hard drive. The Mac must be connected to the Internet, 
and MacTCP or Open Transport must be properly installed and configured. Unlike the original 
NewsWatcher, YA-NewsWatcher is not guaranteed to run on machines without Color QuickDraw 
(which includes all 68000 Macs).

NewsWatcher (both versions) is distributed as a “fat binary.” This means that it runs in native 
68K mode on Motorola 68K Macintoshes, and it runs in native PowerPC mode on Power 
Macintoshes. 

For dialup use, NewsWatcher (both versions) works with the various SLIP and PPP programs, 
and with ARA together with an appropriately configured AppleTalk/IP gateway. It is strictly an 
online newsreader, and it does not support any other kind of dialup connection. The program 
requires an active full TCP/IP connection to the Internet. It does not support offline 
newsreading, and it does not support older kinds of dialup connections designed primarily for 
simple terminal emulation. We have no plans to add these features. If you need an offline 
newsreader or a newsreader which works with older kinds of dialup connections, you must use 
some other program.

The original NewsWatcher was written by John Norstad of Northwestern University:

   mailto:j-norstad@nwu.edu

If you have a comment, question, or suggestion about Yet Another NewsWatcher, please read 
the user documents for the program before writing to any of the authors. Most questions are 
answered in John Norstad's user document for the original NewsWatcher. In particular, see the 
“Getting Started” chapter for basic instructions on how to use the program, and see Appendix 
F for a list of “Frequently Asked Questions” (FAQs) and their answers. If you don’t have a copy 
of the user document, you can get it via anonymous FTP. 

Additional information is contained in the various user documents that accompany Yet Another 
NewsWatcher.

Before writing or posting to ask for help or report a problem,  make certain you have the most 
recent version of the program.

The program is based on the original version 1.0.2 written by Steve Falkenburg of Apple 
Computer. John Werner of Taligent is a major contributor. Thanks also to the following people 
who helped test development and beta versions, helped with design discussions, and/or helped 
with code contributions: Apple DTS, Steven Carmody, Steve Dorner, Adam Engst, Ron Flax, 
Aaron Giles, Haydn Huntley, Steve Klingsporn, Jean-Pierre Kuypers, Robert Lentz, Peter Lewis, 
Jim Matthews, Andrea Norstad, Jeremy Norstad, Lasse Hillerøe Petersen, André Pirard, Quinn, 
Howard Rafal, Pete Resnick, Craig Richmond, Larry Rosenstein, Leonard Rosenthol, Jeroen 
Scheerder, Michael Shappe, Eric Slosser, Stephan Somogyi, Neal Trautman, Dean Yu, Mahboud 
Zabetian, Willem Nijenhuis, Bill Stewart-Cole, Andreas Prilop, Mizutori Tetsuya, Xiaolin Zhao, and 
the nice people on comp.sys.mac.comm.

The regular expression code is a slightly modified version of code by Henry Spencer. The 3-D 
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button controls are slightly modified versions based on code by Zig Zichterman. The Infinity 
WDEF was written by Troy Gault. The plugin interface for the extended character set 
conversion was designed and written by Dan Crevier.

Special thanks to Steve Dorner, both for his advice and assistance, and for his “Eudora” mail 
program, which has served as a consistent source of inspiration for NewsWatcher in particular 
and as a standard of excellence for Macintosh Internet software in general.

NORTHWESTERN UNIVERSITY AND BRIAN CLARK PROVIDE YET ANOTHER NEWSWATCHER AS IS, 
WITHOUT ANY WARRANTY OR PROMISE OF TECHNICAL SUPPORT. NORTHWESTERN UNIVERSITY 
AND BRIAN CLARK DISCLAIM ANY LIABILITY OF ANY KIND FOR ANY DAMAGES WHATSOEVER 
RESULTING FROM THE USE OF YET ANOTHER NEWSWATCHER, INCLUDING, WITHOUT LIMITATION, 
INCIDENTAL, CONSEQUENTIAL, INDIRECT OR SPECIAL DAMAGES OF ANY KIND, EVEN IF 
NORTHWESTERN UNIVERSITY OR BRIAN CLARK ARE AWARE OF THE POSSIBILITY OF SUCH 
DAMAGES. NORTHWESTERN UNIVERSITY AND BRIAN CLARK MAKE NO WARRANTIES, EXPRESS OR 
IMPLIED, WITH RESPECT TO THE PROGRAM, INCLUDING BUT NOT LIMITED TO WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 

Portions Copyright © 1994-1996 Northwestern University.
Portions Copyright © 1994-1996 Brian Clark.
Portions Copyright © 1996 Dan Crevier.
Portions Copyright © 1986 by University of Toronto.

�ADDITIONAL INFORMATION

This version is NOT an "official, John Norstad" version of NewsWatcher. John can't and won't 
support it, and is not responsible for any bugs  added in YA-NewsWatcher. It is also NOT 
supported or endorsed in any manner by Northwestern University or ACNS. Questions or 
comments regarding problems or support should not be directed towards John Norstad or 
Northwestern University or ACNS.

The restrictions imposed by John Norstad and Northwestern University regarding the use, 
distribution, and modification of NewsWatcher also apply to YA-NewsWatcher.

NEW OR CHANGED FEATURES IN YET ANOTHER NEWSWATCHER

This section documents the features in YA-NW that are either entirely new or which are 
different from those found in original NewsWatcher.

1) A number of small cosmetic changes have been made. The spinning beach ball cursor has 
been replaced with a color animated cursor (the small NewsWatcher newspaper icon, with a 
spinning globe). The panel area of windows is drawn in light gray. The icon pseudo-buttons in 
message windows have been replaced with genuine icon checkbox controls that are drawn in a 
3-D style (as are the other buttons in the panel area).

2) The dialog to select folders has been changed to satisfy the Apple Human Interface 
Guidelines, and it's now a little smarter about aliases to volumes.
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3) The subject line to file name routine has been changed to be more intelligent and to provide 
less mangled file names when saving articles to disk which try to maintain part (n/m) numbers 
in the file name.

4) The detection of Base64 encoded binary files has been added, with decoding via a new helper 
application "Yet Another Base64 Decoder." Unlike MPack, this new decoder will handle (indeed it 
requires) the concatenation of all parts of the original message, and it will run in the 
background without user interaction after being sent an apple event. Posts with Base64 
attachments will now be handled just like those with uuencoded or binhexed attachments. 
Starting with version 1.2.0 YA-Base64 also handles uuencoded attachments, and is the 
recommended uudecode and Base64 helper application.

5) Added a number of other options relating to extracting binaries. All these options are set in 
the “Extracting Binaries” portion of the Preferences dialog. If “Keep Bad” is checked, YA-NW 
will not delete any binaries that it starts to download and then determines that they are bad in 
some way (incomplete, or not a recognizable binary format, or ...) Also, each of the decoder 
helper apps has an “Auto launch” checkbox. If checked, the decoder will be automatically 
launched when YA-NW starts up, and will be quit when YA-NW quits. This keeps the decoder 
apps from launching and quitting with each binary being extracted, which can slow down the 
decoding process.

6) A new item has been added to the Special menu to disable or re-enable the truncation of 
messages that seem to be binary posts. Sometimes the logic used to detect binary posts fails, 
causing normal text messages to be truncated. This menu option lets you (presumably 
temporarily) disable truncation so that the message can be read, or printed or ...

7) The time that articles are kept in the cache has been reduced from 60 to 30 days.

8) The option to flush (empty) the article cache when quitting by holding down the option key 
when selecting Quit has been added. There's a confirmation dialog so that you can change your 
mind about emptying the cache. A large cache can cause some out of memory errors, since the 
number of articles actually added to a subject window for processing and actual display is the 
number fetched PLUS the number in the cache. The latter number can be very large, causing 
apparently inexplicable memory problems. Note that, if you have the option to backup your 
prefs file enabled, you can "undo" the cache flushing by using the backup prefs file the next 
time YA-NW is launched (the article cache is stored in the prefs file).

9) The ability to save or extracting binaries from multiple open windows, or send messages in 
multiple open windows has been added. By holding down the shift key while selecting Save from 
the File menu, all open windows of the same kind as the topmost window will be saved. For 
example, if a subject window is topmost, all the selected articles in all open subject windows will 
be saved to disk. If a user group window is topmost, all the user group windows will be saved. 
Similarly, if shift is held down when choosing Extract Binaries, all selected articles in all open 
subject windows will have their binaries extracted. In all cases, the way this works is that the 
topmost window is processed normally, then the windows are cycled through one by one, until 
you're back at the original window. During the cycling, whenever the new topmost window is the 
same kind as the original topmost window, the save or extract binaries operation is performed 
on it. Note that this all happens sequentially. There is still no thread manager support for doing 
multiple tasks simultaneously.
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Similarly, you can send all the open message windows by holding the shift key when clicking on 
the Send button or selecting Send from the News menu. This works by rotating through the 
open windows as described above. The difference, of course, is that each message window is 
closed after it is successfully sent.

10) Full support for binary posting has been added. See the “YA-NW and Binary Posting” 
document for more information.

11) The ability to filter articles has been added. See the “YA-NewsWatcher and Filtering” 
document for details.

12) Article sorting in subject windows was added. See the “YA-NW and Sorting/Threading” 
document for details.

13) Support for scrolling digest articles to the next subject has been added. When reading an 
article, the 'b' key now scrolls to the first line beginning with "Subject: " following the current 
insertion point. If the "Spacebar digest shortcut" item in the Newsreading Options preference 
dialog is checked, digest processing is also mapped to the space bar. For both keys, the default 
space bar processing occurs if no "Subject: " lines are found. (Note that digest processing 
requires that the Main Keyboard Shortcuts" preference be selected.)

14) Added support for posting or mailing messages using anonymous remailers. Please read 
the document "YA-NewsWatcher and Anonymity" for information on this subject.

15) Improved marking as read of cross-posted articles. In original NewsWatcher, only articles 
that were opened had any cross-posts also marked as read. Now this also occurs when an 
article is saved to a file (including binary extraction) from a subject window.

16) Improved the handling of the .newsrc file. Added a dialog when there is a failure trying to 
automatically send a group list to a remote host. You are given the option of ignoring the 
failure (which allows the group window to be closed without sending the group list to the remote 
host), or proceeding normally (which means you get a second dialog explaining what error 
occurred, and the group window is not closed). If you often experience network problems when 
fetching or sending the group list, you probably should not have these operations done 
automatically. But if you do keep this option enabled, and you encounter errors sending the 
group list to the remote host, you can now close the group list window without successfully 
sending the to the remote host. If you haven't saved the group list locally, you'll see the usual 
dialog asking if you want to save your unsaved changes.

Also, in original NewsWatcher the .newsrc file would be ftp'd back to your host system only if it 
had unsaved changes. Of course, f you saved the group list on your Mac, and then made no 
further changes, the .newsrc file was considered unchanged and was not automatically ftp'd 
back to your host system when the group list window was closed. You had to manually send the 
.newsrc back in this situation. This behavior has been changed. What happens now is that the 
.newsrc file will be ftp'd back if it has changed since it was last ftp'd. In addition, if you also 
save the user group list on your Mac, you will get the usual unsaved changes prompt even if the 
.newsrc has been ftp'd to your host machine. In effect, the state of saved or unsaved changes 
is handled separately for ftp'ing the .newsrc file and the local user group list file.

- 6 -



17) Added an option to modified the behavior of the "Next Group" command (and other 
commands that translate to this, such as pressing the enter key. Previously, even if there 
were still unread articles in the group (because there were more article that the number 
fetched from the news server), the next newsgroup in the list would be opened. Now, when the 
"Next Group Command Ignores Unread Articles" option in Newsreader Options is not checked, 
this only happens if there are no unread articles in the current group. If there are unread 
articles, a new subject window for the current newsgroup is reopened with newly fetched 
unread articles.

18) Added the "Get  Newsgroup FAQ" command to the Special menu that may be used to get 
the FAQ for many newsgroups via the Ohio State web server using your specified http helper 
application. Also, the “Get Newsgroup Descriptions” command was added to get the short 
descriptive text that is sometimes available from the news server to describe the purpose of 
newsgroups. Note that these commands do not always yield the information that you seek. The 
Ohio State web server  doesn’t have a FAQ for every newsgroup in existence, and many news 
servers also don’t have descriptions for all the newsgroups they carry. 

19) Changed the labeling for icon buttons. When "Show Icon Labels” is enabled, and the mouse 
is over an icon button in a group, subject, or message window, a prompt explaining the function 
of the button is displayed in the area below the icon buttons.

20) Added the option to have a horizontal scroll bar in subject windows. In previous versions, 
the width of the subject was truncated as needed o fit all the displayed fields within the subject 
window. The narrower the window was made, the more severely the subject was truncated. 
There's now a new subject windows options preference to instead use a horizontal scroll bar, 
and maintain the full subject width (or at least he first 79 characters of the subject).

21) If "Show line counts" is enabled for Subject windows, when saving a file (binary or 
otherwise) to disk, the NewsWatcher Status dialog will show progress information (i.e. "Saving 
File 1 of 2 line 200 of 566").

22) Added the option to hide the status window (except at startup, since he window is shown 
before the preferences are read). When the status window is hidden, and there's therefore no 
cancel button to press, you can still cancel a long process by pressing command-period. The 
status window can also be made either a normal window or a floating window via a checkbox 
option in Miscellaneous Options in the Preferences dialog. If it’s a floating window, it can be 
anchored to the menubar by selecting the “Anchor Status” command in the Windows menu. 
Once the status window is anchored at the top of the screen, newly opened or resized windows 
will be sized and positioned so they are not obscured by the status window. If desired, the 
window can subsequently be unanchored using the “Unanchor Status” command in the Windows 
menu.

23) Increased the maximum length of header that can be fetched from the server from 255 to 
4095 characters. This will help to alleviate a problem some people have encountered when 
trying to filter using the References: header (filtering failed when the long header was 
truncated at 255 characters).
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24) Added a checkbox to Subject Window Options preferences dialog to have read messages 
removed from subject windows when they are refiltered.

25) YA-NewsWatcher can now optionally create section breaks when encountering new MIME 
sections in article windows. This is useful for hiding the MIME “enhanced” text produced by 
newsreaders like Cyberdog.

26) The format of the Path: and Message-ID headers has been modified somewhat. they now 
conform more closely with the so-called “Son of RFC 1036.” A side benefit is that posting may 
be faster on some systems because the user’s machine name is no longer fetched from the 
host when creating these headers.

27) There is a new checkbox in the “Server Options” portion of the Preferences dialog. If “Use 
XOVER Command” is checked, YA-NewsWatcher will use the XOVER command to fetch the 
subject, author, date, line count, (and other currently undisplayed and unused) headers when 
creating a new subject window. If you have “Show Authors,” “Show Dates,” etc. enabled in the 
“Subject Windows” portion of the preferences dialog, then checking “Use XOVER Command” 
may result in better performance, especially if you commonly read newsgroups with few unread 
articles. If instead the newsgroups you read often contain hundreds of unread articles, the 
speed penalty of the extra and unused headers fetched using XOVER may outweigh the 
advantage gained by not having to send multiple commands to the news server. It may also 
require you to substantially increase the empry allocation for the program, particularly if you 
have the progarm configured to fetch many articles at once, or you have many subject or 
article windows open at once.

Finally, as with the other options under “Server Options,” not all news servers support this 
command. Also, some news servers may accept the command and then send garbled headers. 
If YA-NewsWatcher detects this, it displays an alert that says:

The headers obtained using XOVER are damaged or malformed. You should immediately disable 
the “Use XOVER” option and notify the news server admininstrator. Failure to heed this 
warning may result in a crash.

If you see this alert, the safest course of actions is to immediately cancel the operation and 
quit the program. Then notify the news server administrator. The next time you start 
YA-NewsWatcher, go into the “Server Options”portion of the Preferences dialog and uncheck 
“Use XOVER Command.”

28) Added support for using a Eudora Nicknames file. There's now a new panel in the 
preferences dialog. From there you can specify a Eudora Nicknames file that will be 
automatically converted and saved to a new file, called YA-NewsWatcher Nicknames, stored in 
the YA-NewsWatcher Settings folder, when the program starts up. A new “Insert Recipient” 
hierarchical menu in the Edit menu then lets you insert an email address stored in the 
nicknames file. Note that, at present, when you select a nickname from the “Insert Recipient” 
menu, the actual email address and not the nickname is inserted. This is unlike Eudora, which 
inserts the nickname and only later changes it to an email address. YA-NewsWatcher never 
tries to interpret an entry in an email address field as a nickname and expand it into an email 
address.
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29) Added a “Newsgroup Settings" menu item. This leads to a three level dialog that allows 
certain preferences (subject window font, article font, sort order, headers to display, default 
message window font and encodings etc.) to be set on a newsgroup by newsgroup basis. These 
settings override those in the preferences dialog.

30) It's now possible to specify other than Mac->Latin1 and Latin1->Mac character 
transliterations when sending messages or viewing posts. When sending a non-binary message, 
YA-NewsWatcher now includes the appropriate MIME headers indicating the character set in 
use. For more information of this feature, see the document “YA-NW and Character Sets.” It’s 
also possible to change the font or charset for an article window after it has been opened, 
using the “Article Format” command in the Edit menu.

31) Added support for automatic startup activities. Files within a folder named 
"YA-NewsWatcher Startup" located in the same folder as the   active preferences file will 
automatically be opened when the program   starts up. This can be inhibited by holding down the 
shift key during startup. A new item in the miscellaneous section of the preferences dialog, 
"Open Newsgroup at Startup," lets you set whether or not the first newsgroup in the topmost 
user group list window will be automatically open after startup.

32) Added the Export command to the File menu. This writes the contents of a group or 
subject list window to a tab-delimited text file. The file creator and default save-to folder are 
the same as for saving article files.

Note that, in general, the data written to the file is slightly different from that displayed in the 
window. Group lists will always have four columns of data: the low message number (never 
shown in the window), the high message number (ditto), the unread count (only shown in user 
group windows), and the group name. For user group windows, none of the columns will be 
empty. Other group list windows, such as the full group list, the columns other than the group 
name column will be empty. The same format is used for all types of group windows to make 
comparisons and automated processing easier. For subject windows, all the available article 
information will be listed, even if it's not shown in the window (because, for example, "Use 
XOVER" is enabled but "Show lines" is disabled). However, some information (the number of 
articles in a thread, for example) is not written to the file. Again, the format will be the same 
for all subject windows, with empty columns used for unavailable data. For both kinds of lists, 
the order of the items in the export file is the same as that shown in thw window. Also, for 
subject windows, the exported file will only show the first article in a thread unless that thread 
is expanded.

33) Added support for decoding MIME encoded (per RFC 1522) headers. Headers encoded 
according to RFC 1522 are now always decoded in article windows, and optionally decoded in 
subject windows. For the latter there's a new preference to enable or disable decoding of MIME 
headers (since decoding takes time and may therefore cause subject windows to open more 
slowly). This option has also been added to the Subject Options in the Newsgroup Settings 
dialog, so MIME header decoding can be enabled or disabled on a newsgroup-by-newsgroup basis.

34) Added support for Frontier Menu Sharing.

*-*-*-*
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Special thanks to John Norstad for all his hard work on original NewsWatcher. YA-NewsWatcher 
would not be possible without the complete and sturdy foundation offered by original 
NewsWatcher.

Brian Clark
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